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dari meja Penasihat

Assalammualaikum w.b.t , Salam Sejahtera dan

Salam Perak Amanjaya,

Alhamdulillah, bersyukur ke hadrat llahi kerana dengan izin dan limpah
kurnia-Nya, Buletin Geospatial Negeri Perak Edisi 2/2017 dapat diterbitkan
dengan jayanya. Terima kasih kepada sidang redaksi yang bertungkus lumus
dalam memastikan buletin ini menemui pembacanya.

Memandangkan minat yang tinggi telah ditunjukkan oleh pelbagai jabatan /
agensi terhadap teknologi GIS, ianya merupakan faktor pendorong kepada
sidang redaksi untuk meneruskan usaha dalam menyebar dan
mengumpulkan maklumat khusus berkaitan GIS.

Kandungan buletin kali ini merangkumi empat (4) rencana teknikal iaitu Info
Teknologi Maklumat (IT) yang menitikberatkan isu serangan e-mel sasaran,
pengenalan teknologi jarak jauh atau lebih di kenali sebagai Light Detection
and Ranging (LIDAR), fungsi utama dalam Peta Interaktif PerakGIS dan
penggunaan Geoprocessing Tools di dalam perisian QGIS. Aktiviti-aktiviti Unit
PerakGIS sepanjang bulan Julai hingga Disember 2017 turut dimuatkan
dalam edisi kali ini.

Sebagaimana biasa, buletin ini merupakan wadah yang disediakan untuk
pembaca berkongsi maklumat dan teknologi terkini berkaitan aktiviti GIS di
Negeri Perak. Sehubungan itu, pihak sidang pengarang menyeru mana-mana
pihak yang terlibat dalam bidang GIS menyumbangkan sebarang bentuk
hasil kajian atau aktiviti untuk dimuatkan dalam Buletin Geospatial Negeri
Perak bagi edisi-edisi yang seterusnya.

Akhir kata, saya berharap segala maklumat yang dimuatkan dapat
dimanfaatkan bersama oleh semua pihak yang terlibat secara langsung atau
tidak langsung dalam bidang geospatial. Kegemilangan GIS bergantung
sepenuhnya kepada teknologi-teknologi yang memberikan tumpuan kepada
pembinaan pangkalan data, analisis data dan persembahan data. Jika
berlakunya penyalahgunaan data geografi atau geoinformasi, maka akan
terjejaslah masa depan teknologi GIS. Dengan itu, kesedaran mengenai GIS
perlu disemai kepada setiap jabatan bagi membantu teknologi yang sedia
ada agar dapat dimanfaatkan kegunaannya bersama.

Selamat membaca. Sekian, terima kasih.



INFO I.T

E
M

RANGAN

EL SASARAN

Dalam kes serangan terkini, kaedah yang digunakan adalah dengan menyamar sebagai e-mel dari personaliti /
organisasi yang boleh dipercayai oleh mangsa. Nama jabatan dan / atau individu yang benar-benar wujud
digunakan, di samping menggunakan kandungan atau maklumat sulit yang hanya pihak-pihak tertentu yang

mengetahui.

Jika virus disertakan dengan emel, membuka lampiran akan menyebabkan sambungan automatik ke pelayan
luaran dan maklumat dalam komputer akan disalin dan dibocorkan.

LANGKAH KESELAMATAN

Jangan buka sebarang lampiran e-mel atau
klik URL yang mencurigakan.

Jika anda perlu atau terpaksa membuka
e-mel yang mencurigakan, jangan panik dan
jangan mematikan peranti. Putuskan
sambungan rangkaian dan minta bantuan
daripada pentadbir sistem.

Pasang perisian antivirus dan pastikan ia
sentiasa dikemaskini dengan versi terbaru.

Pastikan semua aplikasi sentiasa dikemaskini
secara berkala.
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PETA INTERAKTIF PERAKGIS

FUNGSI - FUNGSI DI DALAM PETA INTERAKTIF

Terdapat tiga (3) fungsi utama di dalam Peta Interaktif PerakGlS iaitu:

1)
2)
3)

Carian Data
Kiraan Jarak dan Luas
Kiraan Radius

Pada edisi ini, pengguna akan mempelajari fungsi yang pertama iaitu carian data.

1. Mulakan aplikasi Peta Interaktif PerakGlIS
« Laman web : www.perakgis.my
« Klik pada menu aplikasi gis | story map
- Klik pada gambar Peta Interaktif PerakGIS

2. Paparan laman utama Peta Interaktif PerakGIS
« Klik pada daftar masuk
« Klik pada pengguna awam, kemudian masukkan id pengguna dan kata laluan yang diberikan

3. Klik pada ikon peta, paparan aplikasi Peta Interaktif PerakGIS akan dipaparkan.

B Maps [E) External Providers  View €3 Google StreetView

h [l Moptin & Select Radius @ Seloct Polygon

& Task List v
Panduan kepada pengguna :

1w | " = - & [¥IED LoT kaDASTER

Legend

1 VB KATEGORI TANAH
3 | penTaceIRAN
Le9end. ik pada menu Legend untuk melinat senarai layer yang dipaparkan g 5 VIE SEMPADAN PENTADSIRAN
| ¥ eanoar
VI sempacan pexan

i R . % BI] semeapen penTaDBIRAN
o L1 - 5

cth: Google Street, Google Hybrid dan lain-lain J'D e e
R B : > R — =[G SEMPADAN MUKIM
- Goose srsetview N yer : " i Rt X V1] MUKIM KUALA KANGSAR
- 2 B 7 . - FI0] mukam MiLIR PERAK
7| mukam PERAK TENGAH
1] muram Moy PERAK
0] mukam kampar
I mukam muaLim
1] mukam kerian

= Measure

=1 % B Butter(radius) - mengira radius bagi point yang dipiin

| || #%erre 17 eature info - mendapatkan makiumat bagi layer yang dipilin

T Query

th: nodot = 1123

& Theme
pengguna refresh

£ Rediine Rediine - Melakar point, line dan polygon baru

./ “Bandar Tambu
| BANDARIWOH(S)  E%
2 ) Sungai R &

DAEF
Kinta

LAs
)

Snbas: | o welection I1:] 2256 5004 | 1131.63 x 528.49 (m)

Untuk pengetahuan pengguna, fungsi-fungsi ini terdapat pada tetingkap Tasks akan dipaparkan pada muka hadapan peta.

Pengguna akan mempelajari dua perbezaan carian iaitu carian lot dan carian bagi data-data yang lain

1. Carian Data |m

- Pada tetingkap task, klik pada task list = Measure
- Klik pada ikon query, akan dipaparkan query features ¥ suffer

;\% Feature Info
W Query

& Theme

£3 Redline
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PETA INTERAKTIF PERAKGIS

1.1. Carian lot

Tasks
@ " D Task List v
Query Features

"
»
x

Select a Layer

Layer:

ﬁ)TMANJuNG M |-—| Pilih layer lot yang diperlukan |
Property Filter
Property:

Lot v|__| Pilih atribut yang perlu dicari |

Tator.
Equalto v
Value:

Fst |_| Masukkan nombor lot |
Spatial Filter
Output

Output property:
|mun<n.1 .|-_| Pilih hasil carian |

[TExecute | waxresuts: 100 ] Klik butang execute untuk paparan
Results hasil carian.

:40 - Bandar Lumut o - -
72 - Pekan Changkat Keruing { Pilih dari senarai |
04 - Pengkalan Baharu
03 - Lumut

80 - Pekan Gurney

o Select dan Zoom kepada hasil

Scale: 10000 Zoom Select = carian.

Maps [T] External Providers  View € Google Streetview

& & P Frackiiav
Query Features

e RN E o CR ¢ ~ NN

Tokong|Cina I'umut
' 0 of ¥
SUK(C) ENG LING i&8 5y

il

¢ ARl dy, Lumut
|1 faatura(s) selacted on 1 layer(s) ls ::264972 | =es.81 x 254.25 (m)

Rajah 1 : Paparan hasil carian lot 351 bagi Mukim Bandar Lumut

bersambung pada edisi akan datang...
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QUANTUM GiIS
Intersect (Bersilang)

Intersect akan menghasilkan output layeryang overlap (bertindih) sahaja dimana ia akan mencipta lapisan baru
berdasarkan dua layer kawasan yang bertindih. Kawasan yang tidak bertindih akan dibuang. Fungsi ini boleh
digunakan bagi layer yang berbentuk point, line dan polygon.

1) Klik pada Vector > Geoprocessing Tools > Intersect

2) Masukan Input Vector (pilih layeryang di dalam Layers)

3) Intersect Layer (pilih layer yang ingin ditindihkan)

4) Masukan Output shapefile dengan nama yang bersesuaian kemudian klik OK.

| Raster Database Web Processg Hp | mmm&wmwmmmﬁmw
IBPLRIAR >l =\ PBA DEBREBOR A0S0 0PPLRARKR » e T\ RPBEA
oz wgss ESZRGAQ@- o VI BRR &G Eamagaggs RS Z2Rheaa@- -
-0 U R % O M A (R @We-K-meBEa-O 30 O 0§08 R M ®% MM % kB

i g

Output shapefile

Data Negeri Perak/1 Kadaster 2017/Intersect Kinta.shp 4

X Add result to canvas

0 0%

Scle [1:1,500 || ®/Render Epscianzs (@) [A) l

Scale | 1:1,563

v % Render 75G:4325 (@) () |

Attribute table - = e
Vector Raster Database Web Processing Help
/B h|& 28BS P BEEE ' [DEBROR <0922 RBPLRARR B - &fPAE
FD FNM NAM ALAMAT BA4_POSKOD BAS_STATE_ A P /BRBRRG=<DEH *-mMfasass \RY2Raq@- -
0 BB0100 Restaura ong Suan Co alan Yang Ka 00 Pera ood Q'E@Z'[és :EE&W\"L% 1 B
1 BB0100 Restaurant Yong Suan Coffe... |2, Jalan YangKal... | 31100 Perak Food v CE)
2 |BBO100 Restaurant Yong Suan Coffe... |2, Jalan Yang Kal... |31100 Perak Food
3 Food
2 Food
5 Food
6 Food
7 Food
8 Food
9 Food
10 Food
1 Food
12 Food
13
14
< Fields | Table preview |
L ALy Name Type = Name I Type = [AMoveUp ] Name Type & lAMoveUp ]
30 |RSO_X String(254) E. NAMAPEMILI String(50) _Ai NAMAPEMILI ‘String(SO)
=y e P plruseres ms =50
32 | Cassini_N String(254) 9 14 |GUID String(32) =] Insert 51 GUID String(32) = Insert
33 | Cassini_E String(254) 15 |KEMASKINI Date 52 [ KEMASKINI e
34 | Cassini_N_ String(254) 16 | MLPRINX Real(130) 53 | MLPRINX Real(130)
35 | Cassini_E_ String(254) T Delete 17 |FASA Integer(d) 54 [FASA Integer(4)
36 |RSO_X_Geo String(254) 18 |BLOCK String(20) 55 |BLOCK String(20)
| | hadl ; —
37 |RSO_Y_Geo String(254) = 19 |cLASS String@0) = 56 | CLASS String(20) =
<1 I ) l ] 10} < ]
=l ) | — = | | ==
=) = )
Input Vector Intersect Layer Output Intersect
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QUANTUM GIS

Clip (Klip)
Clip bertujuan untuk memotong lapisan berdasarkan sesuatu sempadan atau polygon.

1) Klik pada Vector > Geoprocessing Tools > Clip

2) Masukan Input Vector Layer (boleh di dalam bentuk Point, Line dan Polygon)
3) Masukan Clip Layer (layeryang dipilih perlulah di dalam bentuk polygon)

4) Masukan Output shapefile dengan nama yang bersesuaian kemudian klik OK.

ealicues (7 Qais 26.1-righton - a3 B

:.Sewammmmwmwm Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help
= BPLRLR > B TR BE DEBRRR A0S 2L APLRARR e T RBE
Nz wsss U ESZARQQQ- - /) BRR &% EEAREE%SE VR ARAQA@- o~
T T T EL YRR @e-E-weBE=-0 50 o 15080 N®AMY 40
3 ; ~ / @

T ® Convex Hulls).

9 Geometry Tools »
4= Tods

Buffer Kedai Makan Kinta
[ Buffer Balai Polis
°

‘ Layess ]
/ 6= v@EO
T £ dipknta
// Buffer

© Kedai Makan Kinta Selected S 3 -
otter Xodoser e £ Clip_

Input vector layer

Buffer Kedai Makan Kinta

Use only selected features
Clip layer
Kadaster Kinta Selected
Use only selected features
Idenchy Reschs Output shapefile
BE@E % =
D:/Data Negeri Perak/1 Kadaster 2017/Clip Kinta.shp
Feature
% Add result to canvas
= @ [ 0% ][ ] oo
Mode | Currentlay | % Auto open form = =

—

Scale (111,563 | v| X Render EPSGi432s J

Attribute table - Clip Ki

Layer Setings Plugins Vector Raster Datsbase Web Processng Hep

/B W mEeS®PoEEE 4 BEOR (0% PLAHAPPRAKR H - & W3E
FCD FNM NAM ALAMAT BA4_POSKOD BAS_STATE_ PRO Re/rea®@ > o~
‘[0 |BB0100 Restaurant Yong Suan Coffe... |2, Jalan YangKal... | 31100 Perak |Food M M % [ER
1 |BB0100 Restaurant AunKhengLimS... |24, Jalan Theatr... | 30300 Perak |Food
2 |BB0100 Restaurant Restoran Tet Shin |25, Jalan Yau Tet... | 30300 Perak Food
3 |BB0100 Restaurant Restoran Rasa S... |29, Jalan Theatr... 30300 ‘Food
4 |BB0100 Restaurant Restoran Tauge ... |49, Jalan Yau Tet... | 30300
5 |BB0100 Restaurant CinaHawker Lot 3, Jalan Sulta... | 30300
6 |BB0100 Restaurant Popiah SS Ali Stall 18, Medan S... | 30300
7 |BB0100 Restaurant Restoran Hainam | 75, Jalan Mustap... | 30250 Table preview About |
8 |BB0100 Restaurant Restoran Fauzish | 78, Jalan Mustap... | 30250
9 |BB0100 Restaurant Medan Selera Da... | Jalan Raja Muda ... | 30100 Name Type
10 |BB0100 Restaurant Chokodok Ragga... |Jalan Sultan Iska... 130000 30 |RSO_X String(254)
11 |BB0100 Restaurant Omm Cafe Jalan Sultan Iska... | 30000 = X
31 |RSOY String(254)
32 | Cassini_N String(254)
@———, 33 | Cassini_E String(254)
7 Show All Features 34 | Cassini_N_ String(254)
35 | Cassini_E_ String(254)
36 |RSO_X_Geo String(254)
37 |RSO_Y_Geo String(254) : 101,086276,4.593836 Sale (11,563  |v| % Render EPsciaas
< \ )
(I

Output Clip

Intersect akan menggabungkan ke dua-dua data yang pengguna pilih. Jika pengguna dapat | /7~ #
lihat Table Manager menunjukkan pertambahan Fields menjadi 56 Table hasil daripada \\#

pertambahan dua data. Manakala Clip hanya akan menggunakan data daripada Input sahaja.
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e-Desa

Sambungan dari edisi 1/2017..

3. Infrastruktur:
Memaparkan pelbagai kemudahan sedia ada di kampung

Jenis Kemudahan

»

Infrastructu

4. Aktiviti:
Memaparkan pencapaian dan aktiviti yang dijalankan sepanjang tahun di kampung

Tahun
Aktiviti
Activities Kete = n.g =
Penganjur
Gambar
E g N B e L s evves LA
About Ag ator Infrastructure Activities Project Gallery Products
B AxTIvVITI
Tahun 2016
Tahun 2016 Aktivits AMALAN GOTONG ROYONG MAILIS
Aktiviti TEAM FUTSAL KG BATU 14 KENDURI PERKAHWINAN
Keterangan  Aktif menyertai pertandingan futsal Keterangan Amalan bergotong royong di majlis
dipenngkat Mukm & Daerah perkahwinan masih dipertahankan
Penganjur Biro Bela Dan Sukan JKKK oleh masyarakat di Kpg. Part Mat

Ali, Kuala Kurau. Berkumpul
lelakiy/perempuan pada petang
sehan sebelum majhs kendun
dengan aktiviti menyediakan
bahan-bshan dan memasak pada
sebelah malam dan disambung
pada awal pagi keesokannya.
Hidangan/jamuan kepada tetamu
masih mengunakan dulang.

Penganjur  Masyarakat Kpg. Parit Mat Ali,
Kuala Kurau, Perak

Tahun 2016 Tahun 2016

Aktiviti PERTANDINGAN BADMINTON Aktivits MESYUARAT JKKK BULAN APRIL
Keterangan ganjurkan pertanding 2016
badminton individu penngakt Keterangan Mesyuarat bulanan JKKK bertempat
mukim, bertempat di gelanggang i Dewan JKKK (Kpg. Nelayan)
badménton Batu 14, yang bermula jam 3.00 petang.
Penganjur  Biro Bela Dan Sukan JKKK Pada masa tertentu mesyuarat
turut di hadini cleh wakil jabstan
kerajsan untuk mencan
peyelesaian terhadap 'ah
tertentu.
Penganjur  JKKK Batu 14/Pant Sg. Melan
Tahun 2016 Tahun 2016
Aktiviti BSERSAMA KOMUNITI NELAYAN Aktiviti TEAM SEPAKTAKRAW
Keterangan Perbincangan antara komuniti Keterangan Team sepaktakraw Biro Belis Dan

Rajah 1 : Paparan antaramuka bagi menu aktiviti

5. Projek:
Memaparkan senarai pembangunan semasa, akan datang dan telah siap di sekitar kampung

Nama Projek
Nama Program
Objektif Projek

Diskripsi Projek
Lokasi Projek

Kos Projek
Sumber Kewangan
Agensi Pelaksana

BULETIN GEOSPATIAL PerakGIS
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e-Desa

6. Galeri:
Memaparkan gambar tempat-tempat menarik, kawasan bersejarah, kemudahan, anak-anak kampung yang
telah berjaya dan sebagainya

Tempat
Tajuk

Deskripsi

alers™ Gambar

Galeri Gambar Kampung Batu 14/Parit Sungai Melan

Tempat Kampung Batu 14/Parit Sungai Melan
Tajuk Gerakan Belia 48 Batu 14,
Deskripsi Tahun 80an

Tempat Kampung Batu 14/Parit Sungai Melan

Tajuk Genarasi Ke 2 Pengasas Kpg BATU 1.

Deskripsi (Berdiri) : Allahyarham Jaafar b. Elonq, Jahari b. Saman, ?, Noorpiah b. Ali (Bertinggung) : Abd. Rashid b.
Mokhtar, ?, Ahmad b. Hj, Maamur

Tempat Kampung Batu 14/Parit Sungai Melan
Tajuk Gerai Makanan ,
Deskripsi Mamu Satay Batu 14

Tempat Kampung Batu 14/Parit Sungai Melan
Tajuk Warung Makanan
Deskripsi Mee Ketam Panit 30 Batu 14

Tempat Kampung Batu 14/Pant Sungai Melan
Tajuk Kuala Kurau ,
Nael i Baty 14 Vinle I{ srni: Darals

Rajah 2: Paparan antaramuka bagi menu galeri

7. Produk:
Memaparkan hasil perusahaan dan perniagaan daripada penduduk kampung

Tempat
Kategori
Jenama
Nombor Telefon
Gambar

Tempat Kampuog Batu 14/Parit Sunga. Melan
Kategori ektrik
Jenama En. Zul Fahmi Ismail Batu 14 / HP: 012-3216372
2 TFER A, Tempat_ Kampung Batu 14/Parit Sungai Melan
e — Kategori Memproses , Udang dijadikan belacan
:‘muf;h Jenama En. Zakaria Che Mat Kpg Nelayan / HP: 012 4664007
e
[ S R

Kampung Batu 14/Pant Sungac Melan

Tingkap, Pintu & Lain-Lain.
Tn. Haji Yusof & Anak- Anak Batu 13, Kuala Kurau, Pk

Kampung Batu 14/Parit Sungai Melan
Khidmat , Menyediakan Rakit Dan Umpan Untuk Kegiatan Memancing

Rajah 3 : Paparan antaramuka bagi menu produk
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INFO GIS
LiDAR

Secara umumnya teknologi penderiaan jarak jauh (remote sensing) telah menjadi salah satu medium yang paling penting
dan bermanfaat dalam mengesan, memeta dan memantau fenomena di atas permukaan bumi pada pelbagai skala.
Teknologi penderiaan jarak jauh ini telah digunakan pada pelbagai medium samaada di daratan, udara dan angkasa bagi
menyokong pelbagai aplikasi penting sebagai contoh pemetaan bencana alam, strategi dalam ketenteraan, perancangan
pembangunan, pertanian, perhutanan dan sebagainya.

Salah satu teknologi penderiaan jarak jauh terkini iaitu Light Detection and Ranging (LiDAR) telah digunakan dengan luas
dalam memetakan kesan dan ramalan bencana tanah runtuh, banjir, gempa bumi, tsunami dan sebagainya. Teknologi LiDAR
merupakan system aktif penderiaan jarak jauh yang menggunakan cahaya dalam bentuk denyut laser untuk mengukur jarak
ke permukaan bumi. Denyut-denyut laser ini akan digabungkan dengan data-data yang lain dalam sistem cerapan data di
udara bagi membentuk maklumat tiga dimensi bagi permukaan bumi dan objek-objek di atas permukaan bumi. Secara
umumnya teknologi LiDAR terbahagi kepada dua kelas utama iaitu LiDAR bagi tujuan pemetaan topografi dan pemetaan
kedalaman air samaada di laut, sungai dan tasik. Teknologi LiDAR yang digunakan bagi tujuan pemetaan topografi
menggunakan laser dalam panjang gelombang inframerah. Manakala teknologi LiDAR yang digunakan bagi tujuan
pemetaan kedalaman air menggunakan denyut laser yang berada dalam panjang gelombang hijau.

Teknologi LiDAR bawaan udara telah digunakan secara meluas dalam pengesanan, inventori dan pemantauan bencana
tanah runtuh di seluruh dunia. Pelbagai inisiatif telah diambil oleh agensi-agensi kerajaan di Malaysia dalam menggunakan
teknologi ini bagi mengurangkan kesan bencana tanah runtuh yang secara umumnya melibatkan kerugian yang amat teruk
serta kehilangan nyawa. Teknologi LiDAR bawaan udara membolehkan cerun-cerun yang mempunyai risiko tanah runtuh
dikenalpasti dan dipantau dari semasa ke semasa.

Model ketinggian permukaan bumi yang diterbitkan dari data LiDAR bagi kawasan tanah runtuh

Selain dari itu teknologi LiDAR juga digunakan dalam pemetaan dan pengukuran pokok bagi tujuan anggaran kadar biomass
yang tersimpan pada setiap kawasan hutan. Kadar biomass ini merupakan salah satu penunjuk yang boleh digunakan dalam
anggaran kadar serapan gas karbon dioksida di udara oleh setiap pokok. Teknologi LiDAR dipermukaan bumi telah digunakan
secara meluas dalam memetakan sifat-sifat pokok secara terperinci dalam bentuk tiga dimensi. Maklumat ini juga boleh
digunakan oleh pengkaji-pengkaji dari bidang lain yang turut memerlukan maklumat terperinci mengenai hutan di Malaysia.

Titik-titik laser yang diterbitkan dari cerapan data LiDAR di kawasan hutan

BULETIN GEOSPATIAL PerakGIS
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AKTIVITI

AKTIVITI UNIT PERAKGIS DARI JUILAI HINGGA DISEMBER 2017

Nama : Lawatan Tapak Sistem Maklumat e-Desa.

Tarikh : Julai - Oktober 2017
Tempat : Daerah Kuala Kangsar, Hulu Perak, Hilir Perak, Larut & Matang, Selama & Bagan Datuk.

Nama : Sesi Perakuan Sempadan Kampung Bagi Sistem Maklumat e-Desa Bersama Penghulu Mukim.

Tarikh : Julai - Oktober 2017
Tempat : Daerah Kuala Kangsar, Hulu Perak, Hilir Perak & Bagan Datuk.

TN Al
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AKTIVITI

Nama : Mesyuarat Pasukan Kerja Geospatial Negeri Perak.
Agensi : JUPEM Negeri Perak & POS Malaysia.

Tarikh : Julai 2017

Tempat : PLANMalaysia@Perak.

aE.
- nlli ==

N Y ,
X -

2
o M
0

|V}

MALAYSIA

Nama : Bengkel Penggunaan Sistem Maklumat e-Desa Daerah Kampar.
Tarikh :7 -9 Ogos 2017
Tempat : Pusat Internet 1 Malaysia Kampung Tualang Sekah,Malim Nawar.

'S ‘ ‘c‘\g}r : ,,."'?':::'

Nama : Bengkel Penggunaan Aplikasi e-Orang Asli Kepada JAKOA Perak / Kedah.
Tarikh : 15 Ogos 2017
Tempat : Bilik Latihan Komputer, Bahagian Pengurusan Maklumat, Bangunan SUK Negeri Perak.

11 BULTIN GEOSPATIAL PerakGIS
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AKTIVITI

Nama : Mesyuarat Pengesahan Sempadan Kampung Daerah Kuala Kangsar Bersama Pegawai Daerah
Kuala Kangsar Bagi Sistem Maklumat e-Desa.

Tarikh : 23 Ogos 2017

Tempat : Bilik Mesyuarat Pejabat Daerah & Tanah Kuala Kangsar

LT

Nama : Lawatan Dari Bahagian Koridor Infrastruktur & Impak Sosial, Jabatan Ketua Menteri Melaka.
Tarikh : 29 September 2017
Tempat : PLANMalaysia@Perak

Nama : Bengkel Verifikasi Data Lot Tanah, Mukim & Daerah Menggunakan Aplikasi e-Sekolah PerakGIS
Bersama Jabatan Pendidikan Negeri Perak.

Tarikh : 3 Oktober 2017

Tempat : Sekolah Rendah Kebangsaan Sayong,Kuala Kangsar.
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AKTIVITI

Nama : Lawatan Pelajar Politeknik Tuanku Sultanah Bahiyah, Kulim, Kedah.
Tarikh : 4 Oktober 2017

Tempat : Unit PerakGIS Negeri Perak

Nama : Mesyuarat Jawatankuasa Teknikal Geospatial MyGDI Negeri Perak.
Tarikh : 20 Oktober 2017

Tempat : Bilik Mesyuarat Utama, Bangunan SUK Negeri Perak.

Nama : Bengkel Penggunaan Peta Interaktif PerakGIS kepada Pejabat Tanah & Daerah &
PLANMALAYSIA@Perak

Tarikh : 10, 17, 24 November 2017
Tempat : Makmal Komputer Pejabat Tanah & Galian Negeri Perak.
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AKTIVITI

Nama : Bengkel Pengemaskinian PDNG Fasa Ill JUPEM
Tarikh : 27 - 29 November 2017

Tempat : Bilik Latihan Komputer, Bahagian Pengurusan Maklumat, Bangunan SUK Negeri Perak.
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Pegawai Daerah Hulu Perak Bagi Sistem Maklumat e-Desa.
Tarikh : 30 November 2017

Tempat : Bilik Gerakan, Pejabat Daerah & Tanah Hulu Perak.
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Nama : Sesi Taklimat & Pengemaskinian Sempadan Kampung bagi Sistem Maklumat e-Desa,
Daerah Perak Tengah.
Tarikh : November - Disember 2017

Tempat : Pejabat Penghulu Mukim (Seluruh Mukim Daerah Perak Tengah)
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geographical information system

Unit PerakGIS Negeri Perak.Tingkat 13, Perak Techno Trade Centre (PTTC) .0ff Jalan Jelapang.Bandar Meru Raya. 30020 Ipoh.Perak Darul Ridzuan.
05-5262581 / 05-5264308 - www.perakgis.my - sgdcperakgis@gmail.com



